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Introduction 

Introducing our most powerful release yet. TheBrain 10 is designed for fast, 
easy knowledge capture and organization. Building upon the ground up redesign 
of TheBrain 9, version 10 enhances your access to information in all aspects of 
the software.  

TheBrain 10 new features include: 

 BrainBox 

 Visible Types and Tags 

 Instant Tag Access 

 Presentation Mode 

 Dark Mode 

 External Attachment Search 

 Additional Export Options 

 And many other enhancements … 

 
 

A video overview of these features is available at Introducing TheBrain 10 

https://www.thebrain.com/products/thebrain/thebrain10 

About this Guide 

This guide covers the new features and changes in TheBrain 10 that have been 
made since version 9. It is intended for people who are already familiar with 

version 9.  

https://www.thebrain.com/products/thebrain/thebrain10
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BrainBox 

BrainBox lets you send information to your Brain quickly and easily. Just click the icon in the 
top-right corner of TheBrain for Windows or macOS for instant access.  Use BrainBox for 
adding information on the go, from your desktop, from the web, anything that you want to 
quickly capture into your Brain, to be categorized later. 

Accessing BrainBox 

The BrainBox Button 

At any time, when you have a Brain open, use the BrainBox button in the upper right 
hand corner of the window to add previously captured content into your Brain. 

1. Click on a Brain to open it. 

2. Navigate to the desired thought where you want to add your content. 

3. Click on the BrainBox icon to display its content. 

 

Figure 1. The BrainBox Button 

4. From here, the file or web page can be: 

• Added as an internal attachment on a new child thought below the 
current active thought. The new thought name will be the file or 

web page name 

• Added as an internal attachment to the active thought 

• Opened in its default application 

• Renamed, deleted and other actions applied from the context 
menu button 
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The BrainBox Tab 

An alternative way to view and manage the content of your BrainBox is available by 
opening BrainBox in its own tab. When you create a new tab, at the bottom of the Brains 
list, you’ll see the Open BrainBox button.  

 

Figure 2. The BrainBox Tab 

Click the Open BrainBox button to open BrainBox in its own tab.  
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Figure 3. The BrainBox Tab 

Use the BrainBox tab to review, edit or delete existing content in your Brainbox. 

 

Figure 4. Editing the Content of BrainBox 

1. Select an item listed in the BrainBox. 

2. Use the toolbar button or right-click to show the context menu to: 

• Open item in its native application for preview 

• Edit the file or link name 
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• Edit the URL 

• Open in Explorer or Finder 

• View the item properties 

• Delete the item from your BrainBox 

Sending Web Pages to BrainBox 

Add information from any web browser with a single click. When you find a page 
you want to capture to be organized later in TheBrain, just click the BrainBox 
extension button or bookmarklet (depending on your browser).  

You must be logged into your Brain account at https://app.thebrain.com in the 
browser you are using in order for the web page to be successfully added into 
your BrainBox. If you are not logged in, clicking on the BrainBox extension from 
your browser will prompt you to do so in the status screen. Once you have 

logged in, return to the desired web page and click the BrainBox button again. 

You can use the browser extension or bookmarklet from any computer, even if 
TheBrain application is not installed on that device. 

 

Figure 5. Clicking on the BrainBox Extension 

To install the BrainBox extension in your preferred browser visit 
https://www.thebrain.com/docs/brainbox and follow the instructions there. 

https://app.thebrain.com/
https://www.thebrain.com/docs/brainbox
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Sending Files to BrainBox 

Send copies of individual files into your BrainBox to be organized and associated 
with thoughts at a later time. No additional set up for this feature is required.  

Windows File Explorer Send to Integration 

From Windows File Explorer, right click on any file and select BrainBox from the 
Send to submenu. TheBrain will be started if it is not already running and the file 
will be added to BrainBox. To setup the Windows File Explorer integration, install 
and run TheBrain 10. 

 

 

Figure 6. Sending a File to BrainBox  

macOS Dock Drag and Drop 

Launch TheBrain application if it is not running already. From any Finder window, 
drag and drop any file to TheBrain icon in the macOS Dock. The file will be 
added to BrainBox. You can also drag the icon from the title bar of many macOS 
apps.  
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Visible Types and Tags 

Types and tags can now be visible in the plex. Want to see a type or tag as a 
child thought? Just link any existing type or tag thought as a child, or as a jump. 
Types are now optionally visible as parent thoughts as well. 
 

 
 

Figure 7. Visible Parent Type and Child Tag 
 

Linkable types and tags eliminate the need to create two thoughts when you 
want to show all instances of a type or tag within the plex. 
 

• Types are visually distinguished by rounded sides. 
 

• Tags are visually distinguished by chamfered corners. 
 

Hiding Visible Thought Types 

Thought types being visible in the plex is optional.  

• To prevent a thought type from being visible in the plex, right click on a 
thought type and uncheck the option for Visible when Parent of Active 
Thought 

 

 
 

Figure 8. Toggling the Visibility of a Thought Type 
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Converting to Type or Tag 

You can easily change a normal thought into a type or tag at any time: 

• Right click on a thought and select Convert to Type or Tag 
 
 

 
 

Figure 9. Convert to Type or Tag 
 
 

• Additionally, tags and types can be changed into a normal thought 
 

Tag Enhancements 

Clickable Tags 

Tag icons that show on thoughts are now clickable. Click any tag that is visible in 
the plex to navigate to that tag thought. 

Replace Tag 

The Replace Tag feature allows you to quickly move a thought through a project 
cycle or simply re-classify its tag attributes. To quickly replace a thought’s tag: 

• Right click on a tag to open its context menu 

• Select the option Replace Tag with and select another tag 
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Figure 10. Replacing a Tag  

Nested Tags 

Tags can be organized under each other so they are easier to organize, navigate 
and apply. 

• Link two existing tags with a parent/child relationship to subcategorize 

• You may also open a tag’s properties to assign it as a sub category of 
another tag 

• Nesting can include multiple tags and multiple layers 

 

Figure 11. Nested Tags  

 

Additional Tag Updates 

• Tags Can have background colors associated with them: 
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o Right click on a tag to open its Properties 

o Colors may be selected for the tag’s text and/or background 

• Tags can be applied to types 

Presentation Mode 

Presentation mode makes your Brain full-screen, hiding the title bar, menu bar, 
toolbar and Brain tabs. On both Windows and macOS the taskbar and dock are 
also hidden. Presentation mode is an excellent viewing option when using your 

Brain for effective and focused discussions.  

• Enter Presentation Mode by selecting it from the View menu  

• Keyboard shortcuts can be used for functionality that is hidden from the 
current view, such as switching amongst open Brain tabs without exiting 
Presentation Mode 

• Just start typing to search and the controls appear and disappear as 
needed.  

 

Figure 12. Before and after switching to Presentation Mode 
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Dark Mode 

 

The all new Dark Mode changes the windows, menus, icons and other user 
interface elements to be predominantly dark grey. Dark Mode allows you to focus 

on your work with subtle colors and fewer distractions.  

• To switch to Dark Mode, open Preferences to the Look and Feel tab. 
Select Dark under the User Interface setting 

• TheBrain will be restarted to apply the change 

 

Figure 13. TheBrain in Dark Mode 

• You may want to modify your Brain Theme to compliment the darker 
interface and tones 
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Search Improvements 

Search now has several additional capabilities that are automatically enabled. 

• External attachments are included in search results 

• Search using automatic acronyms (ex. find "New York Stock Exchange" 
by typing "nyse") 

• Search for thoughts starting with punctuation. You may use this as a 
shortcut to provide fast access to thoughts that you always start with a 
certain type of punctuation. For example, you could use this for people 
(@Mike, @Sally, @Debbie, etc.) or projects (#Ridgeline, #Palmdale, 

#Westly, etc.) 

 

Figure 14. Search Finding External Attachments 

Find and Replace 

Find and replace all occurrences of text within thought names and labels, link 
labels, external attachment paths and URLs 

• Includes support for regular expressions 

• Changes are undoable, however it is still highly recommended that you 
create a Brain Archive (.brz) prior to performing a large Find and Replace 
operation on an important Brain 

• To start, select Find and Replace from the File menu under Utilities 

• Enter the text to be replaced and the text to replace it with 

• Specify where the text occurs. The available locations are: 

o Thought Names 
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o Thought Labels 

o Link Labels 

o External Attachment Paths 

o Attached URLs 

• Use the checkboxes to specify whether letter case is to be ignored and if 
you want to use regex (regular expressions, which allow sophisticated 

pattern matching capabilities) 

• Preview your results prior to executing the change and click Replace 
when ready 

 

Figure 15. Find and Replace 
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Export 

TheBrain 10 features several all-new export options. Export your Brain data 

directly to: 

• Folders - Exports the thoughts in your Brain by converting them to a 
folder hierarchy. 

o Each thought becomes a folder 

o File attachments and notes (saved as .html files) will be contained 

within the appropriate thought folder 

o The folder structure attempts to mimic the parent-child 
relationships between thoughts with parentless thoughts at the top 
level 

o Shortcuts on Windows and symbolic links on macOS are used to 
represent thoughts that are under multiple parents 

• Text Outline (.txt file) - Creates a text outline of thoughts, notes and 
URLs. 

o Indented hierarchy mimics parent-child relationships between 

thoughts 

o Notes are exported as lines starting with a - (dash) 

o URLS are added lines starting with a + (plus) 

• JSON Files - Exports your Brain data in JSON format. 

o Thoughts, links and other types of data are each exported in their 
own .json file 

o Attachments and notes are exported into folders based on the ID 
of the thought or link they are attached to 

o This gives you access to 100% of your data in an open and easily 
parsed modern text format 

To export your Brain: 

• Select Export from the File menu 

• Select the output (Folders, Text or JSON) and click on Export 

• The output location must be an empty directory 

To export just a portion of your Brain, add thoughts first into TheBrain’s Selection 
box and then check the option to Only export the selection in the Export 
window. 
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Figure 16. Exporting a Brain to Folders 

Additional Improvements 

There are many more small (and not so small) improvements in TheBrain 10.  

Notes Improvements 

A preference has been added to control the effect of the Enter key to either 
create a single line break or a paragraph break. 

• Open Preferences and click on the Behavior Tab  

• Next to For new notes, Enter inserts a: select either Single Line Break 
or Paragraph Break 

 

Figure 17. Note Spacing Options 
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Insert thought link button enables searching for a thought and no longer requires 

that the selected text match a thought name exactly. 

• Select desired text or place cursor where a new link should appear and 
click on the Insert Link to Thought button in the notes tool bar 

 

Figure 18. Insert Link to Thought 

Improved Properties Dialog 

All inherited properties, such as from a thought type’s icon, label or colors, are 
displayed in the properties dialog. 

Thought types or tags are indicated clearly in the dialog 

 

Figure 19. Properties Dialog Improvements 

Improved Thought Creation Dialog 

Existing thought matches are displayed even when using the semicolon to create 
multiple thoughts. 

Link to multiple existing thoughts by typing a semicolon. After selecting a thought 
from the existing thought list, place the cursor back in the thought creation dialog 
and continue typing to add additional thoughts. This also allows the option to 
create both new thoughts and link to existing thoughts at the same time. 

Assign tags to existing thoughts as part of the link process. 
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User Interface Improvements 

There have been several enhancements in the user interface such as: 

• Resizable Reports 

• Customizable thought context menus let you eliminate unused commands 

o Open Preferences and select the Behavior tab 

o Check the option for Custom Thought Context Menu 

o Click on Toggle Commands and uncheck options that you would 
like to have hidden 

 

Figure 20. Custom Thought Context Menu 

• Context menus added to search results, reports and type/tag navigation 
lists 

• Duplicate Tab command 

o Right click on a brain tab to duplicate it, showing the same content 

. 

 


